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xiv  ΠΡΟΛΟΓΟΣ

Πρόλογος

Καλωσήλθατε στον δυναμικό κόσμο της ανάπτυξης για smartphones και για ταμπλέτες Android με το 
Κιτ Ανάπτυξης Λογισμικού του Android (Android Software Development Kit, SDK), 2.3.x και 3.x, την 
γλώσσα προγραμματισμού JavaTM και το ολοκληρωμένο περιβάλλον ανάπτυξης (Integrated Development 
Environment, IDE) EclipseTM.
Αυτό το βιβλίο σας παρουσιάζει τεχνολογίες αιχμής κινητής υπολογιστικής για επαγγελματίες 

προγραμματιστές λογισμικού. Στην καρδιά του βιβλίου βρίσκεται η καθοδηγούμενη από εφαρμογές 
προσέγγιση. Παρουσιάζουμε τις αρχές με 13 πλήρεις εφαρμογές Android, που έχουν αναπτυχθεί μέσα 
στο εγγενές περιβάλλον του Android. Τα Κεφάλαια 3–14 παρουσιάζουν από μία εφαρμογή το καθένα. 
Αρχίζουμε κάθε κεφάλαιο με μια εισαγωγή στην εφαρμογή, μια δοκιμαστική εκτέλεση της εφαρμογής, 
που δείχνει ένα ή περισσότερα δείγματα εκτέλεσής της και μια επισκόπηση των τεχνολογιών. Κατόπιν 
προχωρούμε με την λεπτομερή παρουσίαση του πηγαίου κώδικα της εφαρμογής. Ο πηγαίος κώδικας 
για όλες τις εφαρμογές διατίθεται στην www.deitel.com/books/AndroidFP/.
Οι πωλήσεις συσκευών Android και οι φορτώσεις εφαρμογών αυξάνονται εκθετικά. Η πρώτη γενιά 

τηλεφωνικών συσκευών (τηλεφώνων) Android εμφανίστηκε τον Οκτώβριο του 2008. Μια μελέτη της 
comScore® έδειξε ότι μέχρι τον Ιούλιο του 2011, το Android κατείχε το 41,8% του μεριδίου της αγοράς 
smartphones στις Η.Π.Α., σε σύγκριση με το 27% του iPhone της Apple και με το 21,7% του Blackberry1. 
∆ισεκατομμύρια εφαρμογές έχουν φορτωθεί από την Αγορά του Android (Android Market). Περισσό-
τερες από 500.000 συσκευές Android ενεργοποιούνται καθημερινά. Οι ευκαιρίες για τους προγραμ-
ματιστές του Android είναι τεράστιες.
Η ζήτηση για κινητές συσκευές αυξάνεται, καθώς περισσότεροι άνθρωποι βασίζονται στα 

smartphones και στις ταμπλέτες, για να παραμένουν συνδεδεμένοι και να είναι παραγωγικοί, όταν δεν 
είναι μπροστά στους προσωπικούς τους υπολογιστές. Σύμφωνα με την comScore, 234 εκατομμύρια 
Αμερικανοί χρησιμοποιούσαν κινητές συσκευές κατά την διάρκεια μιας περιόδου τριών μηνών που 
τελείωσε τον Ιούλιο του 2011. Απ' αυτούς τους συνδρομητές, το 40,6% χρησιμοποιούσαν εφαρμογές2.
Ο έντονος ανταγωνισμός ανάμεσα στις δημοφιλείς πλατφόρμες κινητής τηλεφωνίας (Android, 

BlackBerry, iPhone, Palm, Symbian, Windows Phone 7 κ.ά.) και ανάμεσα σε φορείς κινητής τηλεφωνίας 
οδηγεί σε ταχεία καινοτομία και σε πτώση των τιμών. Ο ανταγωνισμός ανάμεσα σε δεκάδες κατα-
σκευαστές συσκευών Android καθοδηγεί την καινοτομία σε υλικό και λογισμικό, μέσα στην κοινότητα 
του Android. Σήμερα υπάρχουν πάνω από 300 διαφορετικές συσκευές Android.
∆ιασκεδάσαμε πολύ όταν γράφαμε αυτό το βιβλίο. Γνωρίσαμε και αγαπήσαμε το Android, πολλές 

από τις πιο δημοφιλείς του εφαρμογές και τις πολλές και ποικίλες συσκευές Android. Αναπτύξαμε 
πολλές εφαρμογές Android. Οι εφαρμογές του βιβλίου σχεδιάστηκαν με προσοχή, για να σας εισάγουν 
στην μεγάλη ποικιλία των χαρακτηριστικών και των τεχνολογιών του Android, που περιλαμβάνουν 
ήχο, βίντεο, κίνηση (animation), τηλεφωνία, Bluetooth®, αναγνώριση φωνής, το επιταχυνσιόμετρο, το 
GPS, την πυξίδα, τα widgets, τα App Widgets, τα 3∆ γραφικά και πολλά άλλα. Θα μάθετε γρήγορα, 
όλα όσα πρέπει να ξέρετε για να αρχίσετε να δομείτε εφαρμογές Android – αρχίζοντας με μια δοκιμα-

1.  www.comscore.com/Press_Events/Press_Releases/2011/8/comScore_Reports_July_2011_U.S._
Mobile_Subscriber_Market_Share.

2.  www.comscore.com/Press_Events/Press_Releases/2011/8/comScore_Reports_July_2011_U.S._
Mobile_Subscriber_Market_Share.
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στική εκτέλεση της εφαρμογής Doodlz στο Κεφάλαιο 1 και κατόπιν δημιουργώντας την πρώτη σας 
εφαρμογή στο Κεφάλαιο 3. Το Κεφάλαιο 2 σας καθοδηγεί στην σχεδίαση σπουδαίων εφαρμογών, στην 
εκφόρτωση των εφαρμογών σας στην Αγορά του Android της Google (Android Market) και σε άλλα 
ηλεκτρονικά καταστήματα εφαρμογών, σας εξηγεί τι πρέπει να περιμένετε να αντιμετωπίσετε κατά 
την διάρκεια αυτής της διαδικασίας, σας καθοδηγεί στην λήψη της απόφασης αν θα πωλείτε τις 
εφαρμογές σας ή θα τις προσφέρετε δωρεάν και στην προώθησή τους χρησιμοποιώντας το Internet 
και την προφορική φήμη και σε πολλά άλλα.

Ειδοποίηση Πνευματικών ∆ικαιωμάτων και Άδεια Χρήσης Κώδικα
Όλος ο κώδικας και οι εφαρμογές Android αυτού του βιβλίου προστατεύονται με πνευματικά δικαι-
ώματα της Deitel & Associates, Inc. Τα δείγματα προγραμμάτων μέσα στο βιβλίο προστατεύονται με 
την άδεια χρήσης Creative Commons Attributions 3.0 Unported Licence (creativecommons.org/
licences/by/3.0/), με την εξαίρεση ότι δεν μπορούν να επαναχρησιμοποιηθούν κατά κανένα 
τρόπο, σε εκπαιδευτικό υλικό και σε εκπαιδευτικά βιβλία, σε έντυπη ή σε ψηφιακή μορφή. Μπορείτε 
να χρησιμοποιήσετε τις εφαρμογές αυτού του βιβλίου ως κελύφη για τις δικές σας εφαρμογές, δομώ-
ντας επάνω στην υπάρχουσα λειτουργικότητα. Αν έχετε ερωτήσεις, μπορείτε να έλθετε σε επαφή 
μαζί μας, στην διεύθυνση deitel@deitel.com.

Το Αναγνωστικό Κοινό του Βιβλίου
Υποθέτουμε ότι είστε ένας προγραμματιστής της Java, με εμπειρία στον αντικειμενοστραφή προγραμ-
ματισμό και ότι είστε εξοικειωμένοι με την XML. Χρησιμοποιούμε μόνο πλήρεις, λειτουργούσες εφαρ-
μογές, οπότε αν δεν γνωρίζετε Java και XML, αλλά έχετε εμπειρία με τον αντικειμενοστραφή προγραμ-
ματισμό σε C#/.NET, Objective-C/Cocoa ή C++ (με βιβλιοθήκες κλάσεων), πρέπει να είστε σε θέση να 
κατανοήσετε το υλικό γρήγορα, μαθαίνοντας στην πορεία αρκετή Java, αντικειμενοστραφή προγραμ-
ματισμό στο στυλ της Java και XML.
Το βιβλίο αυτό δεν περιέχει μαθήματα ούτε για την Java, ούτε για την XML, αλλά παρουσιάζει πολλή 

τεχνολογία Java και XML μέσα στο περιβάλλον της ανάπτυξης εφαρμογών Android. Αν ενδιαφέρεστε 
να μάθετε Java, μπορείτε να διαβάσετε ένα βιβλίο για το θέμα αυτό.

Βασικά Χαρακτηριστικά
Καθοδηγούμενη από Εφαρμογές Προσέγγιση. Κάθε κεφάλαιο εφαρμογής (3-14) παρουσιάζει μια εφαρ-
μογή – συζητούμε το τι κάνει η εφαρμογή, σας δείχνουμε στιγμιότυπα οθονών της εφαρμογής σε 
δράση, την εκτελούμε δοκιμαστικά και κάνουμε μια επισκόπηση των τεχνολογιών και της αρχιτεκτο-
νικής που θα χρησιμοποιήσουμε για να την δομήσουμε. Κατόπιν, δομούμε την εφαρμογή, παρουσιά-
ζουμε τον πλήρη κώδικα και τον αναλύουμε μεθοδικά. Συζητούμε τις αρχές προγραμματισμού και 
επιδεικνύουμε την λειτουργικότητα των Android API που χρησιμοποιούνται μέσα στην εφαρμογή. Η 
Εικόνα 1 αναφέρει τις εφαρμογές του βιβλίου και τις βασικές τεχνολογίες που χρησιμοποιούμε για να 
τις δομήσουμε.

Εικόνα 1 Εφαρμογές Android και οι τεχνολογίες που εισάγονται σ' αυτές.

Εφαρμογές Τεχνολογίες

Κεφάλαιο 3, Εφαρμογή Welcome Eclipse και το ADT

Κεφάλαιο 4, Εφαρμογή Tip Calculator ∆όμηση μιας Εφαρμογής Android με Java

00_CONT android.indd   xv00_CONT android.indd   xv 17/5/2012   11:50:33 πμ17/5/2012   11:50:33 πμ



xvi  ΠΡΟΛΟΓΟΣ

Android SDK 2.x. Καλύπτουμε πολλά από τα νέα χαρακτηριστικά, που περιλαμβάνονται μέσα στο 
Android Development Kit (SDK) 2.x, περιλαμβανομένων των Bluetooth, Google Maps και των Camera 
API, των API γραφικών και της υποστήριξης για πολλαπλά μεγέθη και πολλαπλές αναλύσεις οθόνης.

Android SDK 3.x για Εφαρμογές Ταμπλέτας. Καλύπτουμε πολλά απ' τα χαρακτηριστικά του νέου 
Android SDK 3.x για ανάπτυξη εφαρμογών ταμπλέτας, που περιλαμβάνουν κίνηση ιδιοτήτων, γραμμή 
ενέργειας, τεμάχια, ειδοποίηση γραμμής κατάστασης και μεταφορά και απόθεση.

Android Maps API. Η εφαρμογή Route Tracker χρησιμοποιεί τις Android Maps API, οι οποίες σας επι-
τρέπουν να ενσωματώσετε GoogleTM Maps μέσα στην εφαρμογή σας. Πριν να αναπτύξετε μία εφαρ-
μογή χρησιμοποιώντας Maps API. πρέπει να συμφωνήσετε με τους Όρους Υπηρεσίας των Android 
Maps API (περιλαμβανομένων και των σχετικών Νομικών Ειδοποιήσεων και της Πολιτικής Απορρήτου), 
που αναφέρονται στην code.google.com/android/maps-api-tos.pdf.

Eclipse. Το δωρεάν παρεχόμενο ολοκληρωμένο περιβάλλον ανάπτυξης (Integrated Development 
Environment, IDE) Eclipse, σε συνδυασμό με το δωρεάν παρεχόμενο Κιτ Ανάπτυξης Java (Java Development 
Kit, JDK) παρέχουν όλα όσα χρειάζεστε για να αναπτύξετε και να δοκιμάσετε εφαρμογές Android.

Πολυμέσα. Οι εφαρμογές χρησιμοποιούν μια μεγάλη ποικιλία δυνατοτήτων πολυμέσων για το Android, 
που περιλαμβάνουν γραφικά, εικόνες, κίνηση καρέ-καρέ, κίνηση ιδιοτήτων, ήχο, βίντεο, σύνθεση φωνής 
και αναγνώριση φωνής.

Εφαρμογές Τεχνολογίες

Κεφάλαιο 5, Εφαρμογή Favorite Twitter® Searches Συλλογές, Widgets και Προβολές

Κεφάλαιο 6, Εφαρμογή Flag Quiz Προθέσεις και Μενού

Κεφάλαιο 7, Εφαρμογή Cannon Game Κίνηση Καρέ-Καρέ και Χειρισμός Συμβάντων 
Χρήστη

Κεφάλαιο 8, Εφαρμογή Spot-On Game Κίνηση με Ενδιάμεσα Καρέ και Ακρόαση για 
Επαφές

Κεφάλαιο 9, Εφαρμογή Doodlz Γραφικά και Επιταχυνσιόμετρο

Κεφάλαιο 10, Εφαρμογή Address Book AdapterView και Adapter

Κεφάλαιο 11, Εφαρμογή Route Tracker Maps API και Πυξίδα

Κεφάλαιο 12, Εφαρμογή Slideshow Προσπέλαση της Βιβλιοθήκης Φωτογραφιών 
και Ήχου

Κεφάλαιο 13, Εφαρμογή Enhanced Slideshow Σειριακοποίηση Αντικειμένων και Αναπαραγωγή 
Βίντεο

Κεφάλαιο 14, Εφαρμογή Weather Viewer Εφαρμογές με ∆υνατότητες Internet, Υπηρεσίες 
Web και App Widgets

Εικόνα 1 Εφαρμογές Android και οι τεχνολογίες που εισάγονται σ' αυτές.
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Βέλτιστες Πρακτικές Android. Είμαστε οπαδοί των αποδεκτών βέλτιστων πρακτικών Android, κατα-
δεικνύοντάς τις όταν μελετούμε λεπτομερώς τον κώδικα. ∆ιαβάστε το Κέντρο Πόρων μας για τις 
Βέλτιστες Πρακτικές Android, στην www.deitel.com/AndroidBestPractices.

Υπηρεσίες Web. Οι υπηρεσίες Web (Web services) σας επιτρέπουν να χρησιμοποιείτε το Web σαν μια 
πλούσια βιβλιοθήκη υπηρεσιών – πολλές από τις οποίες είναι δωρεάν. Η εφαρμογή Route Tracker του 
Κεφαλαίου 11 χρησιμοποιεί τις ενσωματωμένες Android Maps API για να αλληλεπιδράσει με τις υπη-
ρεσίες Web Google Maps. Η εφαρμογή Weather Viewer του Κεφαλαίου 14 χρησιμοποιεί τις υπηρεσίες 
Web WeatherBug3.

Χαρακτηριστικά
Χαρακτηρισμός Κώδικα. Για να κάνουμε τον κώδικά μας περισσότερο ευανάγνωστο, χρησιμοποιούμε 
τις παρακάτω συμβάσεις χαρακτηρισμού:

Τα σχόλια εμφανίζονται με αυτή την γραμματοσειρά
όλος ο υπόλοιπος κώδικας εμφανίζεται με αυτή την γραμματοσειρά

Χρήση Γραμματοσειρών για Έμφαση. Θέτουμε τους όρους κλειδιά και τις παραπομπές σελίδων για 
κάθε ορισμό όρου σε έντονο πλάγιο κείμενο για να μπορείτε να τους αναγνωρίσετε αμέσως. ∆ίνουμε 
έμφαση στα συστατικά της οθόνης χρησιμοποιώντας γραμματοσειρά Ηelvetica (π.χ. το μενού File) και 
δίνουμε έμφαση σε κείμενο προγράμματος Java ή Android με την εξής ειδική γραμματοσειρά (π.χ. 
int x = 5).
Σε αυτό το κεφάλαιο θα δημιουργείτε γραφικές διεπαφές χρήστη (Γ∆Χ, graphical user interface, 

GUI) χρησιμοποιώντας ένα συνδυασμό οπτικού προγραμματισμού (μεταφορά και απόθεση) και συγ-
γραφής κώδικα. Χρησιμοποιούμε διαφορετικές γραμματοσειρές όταν αναφερόμαστε σε στοιχεία της 
Γ∆Χ μέσα στον κώδικα του προγράμματος κι όταν αναφερόμαστε σε στοιχεία της Γ∆Χ που εμφανίζο-
νται μέσα στο IDE:

• Όταν αναφερόμαστε σ' ένα συστατικό Γ∆Χ, που δημιουργούμε μέσα σ' ένα πρόγραμμα, γρά-
φουμε το όνομα της μεταβλητής και το όνομα της κλάσης του με αυτή την γραμματοσειρά 
– π.χ. "Button" ή "myEditText".

• Όταν αναφερόμαστε σε ένα συστατικό Γ∆Χ, που είναι τμήμα του IDE, γράφουμε το κείμενο 
του συστατικού με αυτή την γραμματοσειρά και χρησιμοποιούμε μια απλή γραμματοσειρά 
κειμένου για τον τύπο του συστατικού – π.χ. “το μενού File” ή “το κουμπί Run”.

Χρήση του Χαρακτήρα >. Χρησιμοποιούμε τον χαρακτήρα >, για να δηλώσουμε την επιλογή ενός 
στοιχείου μενού από ένα μενού. Για παράδειγμα, χρησιμοποιούμε τον συμβολισμό File > New, ώστε 
να δηλώσουμε ότι πρέπει να επιλέξετε το στοιχείο μενού New από το μενού File.

Πηγαίος Κώδικας. Όλος ο πηγαίος κώδικας του βιβλίου διατίθεται για φόρτωση στις εξής διευθύνσεις:

www.deitel.com/books/AndroidFP/
www.informit.com/title/9780132121361

Τεκμηρίωση. Όλη η τεκμηρίωση του Android και της Java που θα χρειαστείτε για να αναπτύξετε 
εφαρμογές Android διατίθεται δωρεάν στην developer.android.com. Η τεκμηρίωση για το Eclipse 
διατίθεται στην www.eclipse.org/documentation.

Στόχοι Κεφαλαίου. Κάθε κεφάλαιο αρχίζει με μια λίστα στόχων.

3. apireg.weatherbug.com/defaultAPI.aspx.
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Εικόνες. Μέσα στο βιβλίο περιλαμβάνονται εκατοντάδες πίνακες, λίστες πηγαίου κώδικα και στιγμιό-
τυπα οθονών του Android.

Ευρετήριο. Περιλαμβάνουμε ένα εκτεταμένο ευρετήριο για αναφορά.

Τα Ηλεκτρονικά Κέντρα Πόρων της Deitel
Τα Κέντρα Πόρων μας (Android Resource Centers) περιλαμβάνουν συνδέσμους προς μαθήματα, τεκ-
μηρίωση, φορτώσεις λογισμικού, άρθρα, ιστολόγια, podcasts, βίντεο, δείγματα κώδικα, βιβλία, ηλε-
κτρονικά βιβλία και πολλά άλλα – και τα περισσότερα απ' αυτά διατίθενται δωρεάν. ∆ιαβάστε την 
λίστα των Κέντρων Πόρων που σχετίζονται με το Android, που περιλαμβάνουν τα εξής:

• Android (www.deitel.com/android/)

• Βέλτιστες Πρακτικές για το Android (www.deitel.com/androidbestpractices/)

• Java (www.deitel.com/java/)

• Eclipse (www.deitel.com/Eclipse/)

• SQLite 3 (www.deitel.com/SQLite3/)

Ευχαριστίες
Είμαστε τυχεροί, επειδή έχουν συνεργαστεί σ' αυτό το έργο με τους αφοσιωμένους επαγγελματίες 
εκδόσεων του Prentice Hall/Pearson. Εκτιμούμε ιδιαίτερα τις τεράστιες προσπάθειες και την 16ετή 
διδαχή του φίλου και επαγγελματία συνεργάτη Mark L. Taub, ∆ιευθυντή Εκδόσεων του Pearson 
Technology Group. Η Olivia Basegio έκανε σπουδαία δουλειά, προσλαμβάνοντας διακεκριμένα μέλη 
της κοινότητας του Android και διαχειριζόμενη την διαδικασία της επιμέλειας. Ο Chuti Prasertsith 
σχεδίασε το εξώφυλλο με δημιουργικότητα και ακρίβεια – του δώσαμε την ιδέα μας και έκανε όλα τα 
υπόλοιπα μόνος του. Ο John Fuller έκανε σπουδαία δουλειά στην διαχείριση της παραγωγής όλων 
των βιβλίων μας.
Θέλουμε να ευχαριστήσουμε τον φίλο μας, Rich Wong (Partner, Accel Partners), ο οποίος μας έδωσε 

όλες τις πολύτιμες επαφές μέσα στις κοινότητες του Android και της ανάπτυξης εφαρμογών για 
κινητές συσκευές.
Θέλουμε να ευχαριστήσουμε την AWS Convergence Technologies, Inc., ιδιοκτήτρια εταιρεία της 

WeatherBug (weather.weatherbug.com), που μας έδωσε την άδεια να χρησιμοποιήσουμε τις υπη-
ρεσίες της Web στην εφαρμογή Weather Viewer του Κεφαλαίου 14.
Θέλουμε να ευχαριστήσουμε επίσης τον συνεργάτη μας, Eric Kern, που μας βοήθησε στην συγγραφή 

ενός αντίστοιχου βιβλίου για iPhone, στο οποίο βασίζονται πολλές απ' τις εφαρμογές αυτού του 
βιβλίου.

Επιμελητές
Θέλουμε να ευχαριστήσουμε τους επιμελητές για την μεγάλη τους προσπάθεια. Συμμορφούμενοι σε 
ένα σφικτό χρονικό περιθώριο, επιμελήθηκαν το κείμενο και τα προγράμματα και μας έκαναν αμέτρη-
τες προτάσεις για βελτίωση της παρουσίασης:

• Paul Beusterien, Principal, Mobile Developer Solutions

• Eric J. Bowden, COO, Safe Driving Systems, LLC

• Ian G. Clifton, Independent Contractor and Android App Developer

• Daniel Galpin, Android Advocate and author of Intro to Android Application Development
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• Douglas Jones, Senior Software Engineer, Fullpower Technologies

• Sebastian Nykopp, Chief Architect, Reaktor

• Ronan “Zero” Schwarz, CIO, OpenIntents

Αυτό είναι λοιπόν! Το βιβλίο αυτό θα σας επιτρέψει να μπορείτε να αναπτύσσετε στα γρήγορα 
εφαρμογές Android. Ελπίζουμε να σας αρέσει η μελέτη του, όσο μας άρεσε εμάς η συγγραφή του!

Paul, Harvey και Abbey Deitel και Michael Morgano, Οκτώβριος 2011.

Οι Συγγραφείς
Ο Paul J. Deitel, ∆ιευθύνων Σύμβουλος και Γενικός Τεχνικός ∆ιευθυντής της Deitel & Associates είναι 
απόφοιτος του MIT, όπου σπούδασε Πληροφορική. Μέσω της Deitel & Associates, Inc., έχει παραδώ-
σει μαθήματα προγραμματισμού Internet και Web, Java, C, C++, C# και Visual Basic σε επιχειρηματι-
κούς πελάτες, περιλαμβανομένων των Cisco, IBM, Siemens, Sun Microsystems, Dell,. Lucent Technologies, 
Fidelity, NASA στο Κέντρο ∆ιαστήματος Kennedy, National Server Storm Laboratory, White Sands Missile 
Range, Rogue Wave Software, Boeing, Stratus, Cambridge Technology Partners, Open Environment 
Corporation, One Wave, Hyperior Sofware, Adra Systems, Entergy, CableData Systems, Nortel Networks, 
Puma, iRobot, Invensys και πολλών άλλων. Αυτός και ο πατέρας του, Dr. Harvey M. Deitel, είναι οι 
δημοφιλέστεροι συγγραφείς βιβλίων σε θέματα γλωσσών προγραμματισμού.
Ο Dr. Harvey M. Deitel, Πρόεδρος του ∆ιοικητικού Συμβουλίου και Γενικός ∆ιευθυντής Στρατηγικής 

της Deitel & Associates, Inc., έχει 50 χρόνια εμπειρίας στον τομέα των υπολογιστών. Ο Dr. Deitel πήρε 
το B.S.και το M.S. του από το MIT και το διδακτορικό του από το Πανεπιστήμιο Boston. Έχει εκτετα-
μένη διδακτική εμπειρία σε κολέγια, που περιλαμβάνουν πολλά χρόνια εμπειρίας στο τμήμα Computer 
Science του Κολεγίου Boston, όπου διατέλεσε και πρόεδρος, πριν να ιδρύσει την Deitel & Associates, 
Inc., μαζί με τον γυιό του, Paul J. Deitel. Αυτός και ο Paul είναι από κοινού συγγραφείς αρκετών δεκά-
δων βιβλίων και πακέτων πολυμέσων και συνεχίζουν να συγγράφουν και άλλα. Τα βιβλία τους έχουν 
μεταφραστεί στα Ιαπωνικά, Γερμανικά, Ρωσικά, Ισπανικά, Κινεζικά, Κορεάτικα, Γαλλικά, Πολωνικά, 
Ιταλικά, Πορτογαλικά, Ελληνικά και Τουρκικά και έχουν κερδίσει παγκόσμια αναγνώριση. Ο Dr. Deitel 
έχει διδάξει σε εκατοντάδες επαγγελματικά σεμινάρια σε μεγάλους οργανισμούς, σε ακαδημαϊκά ιδρύ-
ματα, σε κυβερνητικούς οργανισμούς και σε στρατιωτικά εκπαιδευτικά ιδρύματα.
Η Abbey Deitel, Πρόεδρος της Deitel & Associates, Inc., είναι απόφοιτος του Carnegie Mellon 

Unicersity, Tepper School of Management, όπου πήρε το πτυχίο της B.S. στο Βιομηχανικό Μάνατζμεντ. 
∆ιαχειρίζεται τις επιχειρησιακές λειτουργίες της Deitel & Associates, Inc. για 14 χρόνια. Έχει συνεισφέρει 
σε πολλές εκδόσεις της Deitel & Associates και, μαζί με τους Paul και Harvey έχει συγγράψει τα βιβλία 
iPhone for Programmers: An App-Driven Approach και Internet & World Wide Web How to Program, 5e.
Ο Michael Morgano, Προγραμματιστής Android στην ImerjTM, είναι απόφοιτος του Northeastern 

University, όπου πήρε τα πτυχία του B.S. και M.S. στην Επιστήμη των Υπολογιστών. Έχει συγγράψει 
μαζί με τους παραπάνω το βιβλίο iPhone for Programmers: An App-Driven Approach.
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Αυτή η ενότητα περιέχει πληροφορίες που πρέπει να μελετήσετε πριν να χρησιμοποιήσετε αυτό το 
βιβλίο και οδηγίες που θα χρειαστείτε για να σιγουρέψετε ότι ο υπολογιστής σας έχει διαμορφωθεί 
σωστά για να χρησιμοποιηθεί μ' αυτό το βιβλίο. Θα δημοσιεύουμε ενημερώσεις αυτής της ενότητας 
(αν υπάρχουν) στην ιστοθέση του βιβλίου:

www.deitel.com/books/AndroidFP/

Συμβάσεις Γραμματοσειρών και Ονομασίας
Χρησιμοποιούμε γραμματοσειρές ώστε να διακρίνουμε ανάμεσα σε χαρακτηριστικά, όπως είναι τα 
ονόματα μενού, τα στοιχεία μενού και στον κώδικα Java ή σε εντολές. Η σύμβαση που χρησιμοποιούμε 
είναι να εμφανίζουμε τα συστατικά της οθόνης μ' αυτήν την γραμματοσειρά (π.χ. μενού Project) και 
να εμφανίζουμε τα ονόματα αρχείων, τον κώδικα Java και τις εντολές με αυτή την γραμματοσειρά 
(π.χ. την λέξη-κλειδί public ή την κλάση Activity).

Απαιτήσεις Λογισμικού και Υλικού
Για να αναπτύξετε εφαρμογές Android χρειάζεστε ένα σύστημα Windows®, Linux ή Mac OS X. Για να 
βρείτε τις πιο πρόσφατες απαιτήσεις λειτουργικού συστήματος, επισκεφθείτε την:

developer.android.com/sdk/requirements.html

Αναπτύξαμε τις εφαρμογές αυτού του βιβλίου χρησιμοποιώντας το παρακάτω λογισμικό:

• Java SE 6 Software Development Kit

• Eclipse 3.6.2 (Helios) IDE for Java Developers

• Android SDK εκδόσεις 2.2, 2.3.3 και 3.x

• ADT (Android Development Tools) Plugin for Eclipse

Στην επόμενη ενότητα σας λέμε που θα βρείτε όλο αυτό το λογισμικό.

Εγκατάσταση του Java Development Kit (JDK)
Το Android απαιτεί το Java Development Kit (JDK) (κιτ ανάπτυξης Java) έκδοση 5 ή 6 (JDK 5 ή JDK 6). 
Εμείς χρησιμοποιήσαμε το JDK 6. Για να φορτώσετε το JDK για Linux ή για Windows, μεταβείτε στην

www.oracle.com/technetwork/java/javase/downloads/index.html

Χρειάζεστε μόνο το JDK. Βεβαιωθείτε ότι έχετε ακολουθήσει τις οδηγίες εγκατάστασης που βρίσκονται 
στην:

www.oracle.com/technetwork/java/javase/index-137561.html

Για την Java στο Mac OS X, επισκεφθείτε την:

developer.apple.com/java

Πριν να Αρχίσετε
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xxi  ΠΡΙΝ ΝΑ ΑΡΧΙΣΕΤΕ

Εγκατάσταση του Eclipse IDE
Το Eclipse είναι το συνιστώμενο ολοκληρωμένο περιβάλλον ανάπτυξης (Integrated Development 
Environment, IDE) για ανάπτυξη για το Android, αν και είναι δυνατό να χρησιμοποιήσετε άλλα IDE, 
επεξεργαστές κειμένου και εργαλεία γραμμής εντολής. Για να φορτώσετε το Eclipse IDE for Java 
Developers (για προγραμματιστές Java), μεταβείτε στην:

www.eclipse.org/downloads/

Αυτή η σελίδα θα σας επιτρέψει να φορτώσετε την πιο πρόσφατη έκδοση του Eclipse – 3.6.2, μέχρι 
την ώρα της συγγραφής αυτού του βιβλίου. Επιλέξτε την κατάλληλη έκδοση για το λειτουργικό σας 
σύστημα (Windows, Mac ή Linux). Για να εγκαταστήσετε το Eclipse, απλώς εξάγετε τα περιεχόμενα 
της αρχειοθήκης. Στο δικό μας σύστημα Windows 7, εξάγαμε τα περιεχόμενα στο C:\Eclipse. Για 
περισσότερες πληροφορίες για την εγκατάσταση του Eclipse, δείτε:

bit.ly/InstallingEclipse

Για να σιγουρευτείτε ότι τα παραδείγματα αυτού του βιβλίου μεταγλωττίζονται σωστά, διαμορφώστε 
το Eclipse έτσι ώστε να χρησιμοποιεί το JDK 6, κάνοντας τα εξής βήματα:

1. Βρείτε τον φάκελο Eclipse μέσα στο σύστημά σας και κάντε διπλό κλικ στο εικονίδιο του Eclipse 
( ), για να ανοίξετε το Eclipse.

2. Όταν εμφανιστεί το παράθυρο Workspace Launcher, κάντε κλικ στο OK.

3. Επιλέξτε Window > Preferences για να εμφανίσετε το παράθυρο Preferences.

4. Αναπτύξτε τον κόμβο Java και επιλέξτε τον κόμβο Compiler. Κάτω από το JDK Compliance, 
θέστε το Compiler compliance level σε 1.6.

5. Κλείστε το Eclipse.

Εγκατάσταση του Android SDK
Το Android Software Development Kit (SDK) (κιτ ανάπτυξης λογισμικού Android) σας παρέχει τα 
εργαλεία που χρειάζεστε για να αναπτύξετε, να δοκιμάσετε και να αποσφαλματώσετε εφαρμογές 
Android. Μπορείτε να φορτώσετε το Android SDK από την:

developer.android.com/sdk/index.html

Κάντε κλικ στον σύνδεσμο για την πλατφόρμα σας – Windows, Mac OS X ή Linux – για να φορτώσετε 
το SDK. Αφού το φορτώσετε, απλώς εξάγετε τα περιεχόμενα της αρχειοθήκης σ' έναν κατάλογο της 
επιλογής σας, μέσα στον υπολογιστή σας. Το SDK δεν περιλαμβάνει την πλατφόρμα Android – θα την 
φορτώσετε αυτή ξεχωριστά, χρησιμοποιώντας τα εργαλεία του Android SDK.

Εγκατάσταση του ADT Plugin για το Eclipse
Το Android Development Tools (ADT) Plugin (πρόσθετο εργαλείων ανάπτυξης Android) για το Eclipse 
σας επιτρέπει να χρησιμοποιήσετε τα εργαλεία του Android SDK για να αναπτύσσετε εφαρμογές 
Android μέσα στο Eclipse IDE. Για να εγκαταστήσετε το ADT Plugin, μεταβείτε στην:

developer.android.com/sdk/eclipse-adt.html

και ακολουθήστε προσεκτικά τις οδηγίες για την φόρτωση και την εγκατάσταση του ADT Plugin. 
Σιγουρευτείτε ότι ακολουθείτε τις οδηγίες για την έκδοση του Eclipse που έχετε εγκαταστήσει. ∆ίνονται 
ξεχωριστές οδηγίες για το Eclipse 3.5/3.6 και για το Eclipse 3.4. Αν έχετε προβλήματα με την εγκατά-
σταση, διαβάστε τις οδηγίες αντιμετώπισης προβλημάτων, που βρίσκονται παρακάτω μέσα στην 
ιστοσελίδα.
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Εγκατάσταση της Πλατφόρμας του Android
Τώρα πρέπει να εγκαταστήσετε την πλατφόρμα (ή τις πλατφόρμες) του Android, που θέλετε να 
χρησιμοποιήσετε για ανάπτυξη εφαρμογών. Σ' αυτό το βιβλίο, χρησιμοποιούμε το Android 2.2, 2.3.3 
και 3.x. Κάντε τα παρακάτω βήματα, για να εγκαταστήσετε την πλατφόρμα του Android και τα πρό-
σθετα εργαλεία SDK:

1. Ανοίξτε το Eclipse ( ).

2. Όταν εμφανιστεί το παράθυρο Workspace Launcher, καθορίστε πού θέλετε να αποθηκευτούν 
οι εφαρμογές και μετά κάντε κλικ στο OK.

3. Επιλέξτε Window > Preferences για να εμφανίσετε το παράθυρο Preferences. Μέσα στο παρά-
θυρο, επιλέξτε τον κόμβο Android και μετά καθορίστε την θέση όπου τοποθετήσατε το Android 
SDK στο σύστημά σας, μέσα στο πεδίο SDK Location. Στο δικό μας σύστημα Windows, το εξά-
γαμε στο c:\android-sdk-windows. Κάντε κλικ στο OK.

4. Επιλέξτε Window > Android SDK and AVD Manager για να εμφανίσετε το παράθυρο Android 
SDK and AVD Manager (Εικόνα 1).

5. Επιλέξτε Available Packages. Η αριστερή στήλη του παράθυρου εμφανίζει τις επιλογές Android 
Repository και Third party Add-ons. Αναπτύξτε τον κόμβο Android Repository, ώστε να δείτε την 
λίστα των διαθέσιμων εργαλείων και πλατφόρμων του Android. Γι' αυτό το βιβλίο χρειάζεστε 
τα στοιχεία Android Repository, που είναι επιλεγμένα στην Εικόνα 2.

6. Επίσης, θα χρειαστείτε τα στοιχεία που βρίσκονται μέσα στην υποκατηγορία Third party Add-
ons, τα οποία εμφανίζονται στην Εικόνα 3. [Σημείωση: Το Google USB Driver package είναι 
απαραίτητο μόνο αν αναπτύσσετε εφαρμογές Android στα Windows και σκοπεύετε να δοκι-
μάσετε τις εφαρμογές σας σε πραγματικές συσκευές. Το Google Market Licencing package είναι 
απαραίτητο, μόνο αν σκοπεύετε να αναπτύξετε εφαρμογές, οι οποίες ρωτούν την αγορά του 
Android (Android Market), για να καθορίσουν αν ένας χρήστης έχει μια σωστή άδεια για μία 

Εικόνα 1 Παράθυρο Android SDK and AVD Manager.
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xxiii  ΠΡΙΝ ΝΑ ΑΡΧΙΣΕΤΕ

εφαρμογή, πριν να επιτρέψουν την χρήση της εφαρμογής. Το Google Market Billling Package 
είναι απαραίτητο μόνο αν σκοπεύετε να πωλείτε ψηφιακό περιεχόμενο μέσω της εφαρμογής 
σας].

7. Κάντε κλικ στο κουμπί Install Selected για να εμφανίσετε το παράθυρο Choose Packages to 
install (Εικόνα 4). Μέσα σ' αυτό το παράθυρο, μπορείτε να διαβάστε την άδεια χρήσης για κάθε 
στοιχείο. Όταν τελειώσετε, κάντε κλικ στο κουμπί επιλογής Accept All και μετά κάντε κλικ στο 

Εικόνα 2 Επιλογή πακέτων από το Android Repository προς εγκατάσταση.

Εικόνα 3 Επιλογή πακέτων από το Third party Add-ons προς εγκατάσταση.
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κουμπί Install. Θα εμφανιστεί το παράθυρο Installing Archives (Εικόνα 5) για να σας δείξει την 
κατάσταση της διαδικασίας εγκατάστασης.

8. Όταν ολοκληρωθεί η διαδικασία εγκατάστασης, μπορείτε να δείτε τα εγκαταστημένα στοιχεία, 
κάνοντας κλικ στο Installed Packages στην αριστερή στήλη του παράθυρου Android SDK and 
AVD Manager. Πρέπει να κλείσετε και να ανοίξετε ξανά το Eclipse.

∆ημιουργία Εικονικών Συσκευών Android (AVD) 
για να τις Χρησιμοποιήσετε μέσα στον Εξομοιωτή Android
Ο εξομοιωτής Android, που περιλαμβάνεται μέσα στο Android SDK, σας επιτρέπει να εκτελέσετε 
εφαρμογές Android μέσα σ' ένα περιβάλλον εξομοίωσης στον υπολογιστή σας, αντί να τις εκτελέσετε 
σε μία πραγματική συσκευή Android. Πριν να εκτελέσετε μια εφαρμογή στον εξομοιωτή, πρέπει να 
δημιουργήσετε μία Εικονική Συσκευή Android (Android Virtual Device, AVD), η οποία ορίζει τα χαρα-
κτηριστικά της συσκευής, στην οποία θέλετε να κάνετε την δοκιμή, περιλαμβανομένων του μεγέθους 

Εικόνα 4 Παράθυρο Choose Packages to Install.

Εικόνα 5 Παράθυρο Installing Archives.
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xxv  ΠΡΙΝ ΝΑ ΑΡΧΙΣΕΤΕ

της οθόνης, σε pixels, της πυκνότητας pixels, του φυσικού μεγέθους της οθόνης, του μεγέθους της 
κάρτας SD για αποθήκευση δεδομένων και άλλων πραγμάτων. Αν θέλετε να χρησιμοποιήσετε τις 
εφαρμογές σας για πολλαπλές συσκευές Android, μπορείτε να δημιουργήσετε ξεχωριστές AVD, που 
εξομοιώνουν κάθε συσκευή. Για να το κάνετε αυτό, πράξτε τα παρακάτω βήματα:

1. Ανοίξτε το Eclipse.

2. Επιλέξτε Window > Android SDK and AVD Manager ώστε να εμφανίσετε το παράθυρο Android 
SDK and AVD Manager (Εικόνα 1). Προεπιλεγμένα είναι επιλεγμένο το Virtual Devices στην αρι-
στερή στήλη του παράθυρου.

3. Κάντε κλικ στο New… ώστε να εμφανίσετε το παράθυρο Create new Android Virtual Device (AVD) 
(Εικόνα 6) και κατόπιν διαμορφώστε τις επιλογές, όπως φαίνεται και κάντε κλικ στο Create 
AVD. Αυτές οι ρυθμίσεις εξομοιώνουν το πρωτεύον τηλέφωνο Android – το αρχικό Samsung 
Nexus S, το οποίο εκτελούσε το Android 2.3.3, μέχρι την ώρα της συγγραφής αυτού του βιβλίου. 
Κάθε AVD που δημιουργείτε έχει πολλές άλλες επιλογές, που καθορίζονται μέσα στο αρχείο 
της confi g.ini. Μπορείτε να τροποποιήσετε αυτό το αρχείο, όπως περιγράφεται στην ενό-
τητα Setting hardware emulation options στην:

developer.android.com/guide/developing/devices/index.html

 για να ταιριάξετε ακριβέστερα την διαμόρφωση υλικού με την συσκευή σας.

Εικόνα 6 Παράθυρο Create new Android Virtual Device (AVD).
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4. ∆ιαμορφώσαμε επίσης μια AVD που παριστά την ταμπλέτα Motorola Xoom, η οποία εκτελεί 
το Android 3.1. Οι ρυθμίσεις της φαίνονται στην Εικόνα 7.

Απόδοση της AVD
Μέχρι την ώρα της συγγραφής του βιβλίου, η απόδοση της AVD ήταν πολύ αργή. Για να βελτιώσετε 
τον χρόνο φόρτωσης της AVD, σιγουρευτείτε ότι το πλαίσιο ελέγχου Enabled μέσα στην ενότητα 
Snapshot είναι επιλεγμένη.

(Προαιρετικό) Καθορισμός μιας Συσκευής Android για Ανάπτυξη
Τελικά, ίσως να θέλετε να εκτελέσετε τις εφαρμογές σας σε πραγματικές συσκευές Android. Για να το 
κάνετε αυτό, ακολουθήστε τις οδηγίες της:

developer.android.com/guide/developing/device.html
Αν κάνετε ανάπτυξη στα Microsoft Windows, θα χρειαστείτε επίσης το πρόγραμμα οδήγησης Windows 
USB για συσκευές Android, το οποίο περιλάβαμε ως ένα από τα επιλεγμένα στοιχεία στην Εικόνα 2. 
Σε ορισμένες περιπτώσεις, ίσως να χρειαστείτε επίσης προγράμματα οδήγησης USB για συγκεκριμέ-
νες συσκευές. Για μία λίστα των ιστοθέσεων των προγραμμάτων οδήγησης USB για διάφορες συσκευές, 
επισκεφθείτε την:

developer.android.com/sdk/oem-usb.html

Εικόνα 7 Παράθυρο Create new Android Virtual Device (AVD).
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(Προαιρετικό) Άλλα IDE για Ανάπτυξη Εφαρμογών Android
Αναπτύξαμε όλες τις εφαρμογές αυτού του βιβλίου χρησιμοποιώντας το Eclipse IDE. Αν και αυτό είναι 
το δημοφιλέστερο IDE για ανάπτυξη Android, υπάρχουν και άλλα διαθέσιμα IDE και εργαλεία (Εικόνα 
8). Η ιστοθέση developer.android.com/guide/developing/other-ide.html περιέχει πλη-
ροφορίες και εργαλεία, που θα χρειαστείτε για να διαμορφώσετε, να δομήσετε, να αποσφαλματώσετε 
και να διανείμετε εφαρμογές Android (Εικόνα 9), χρησιμοποιώντας άλλα IDE ή τα εργαλεία της γραμ-
μής εντολής.

Λήψη των Παραδειγμάτων Κώδικα
Τα παραδείγματα του βιβλίου διατίθενται για φόρτωση, από την διεύθυνση:

www.deitel.com/books/androidFP/

IDE URL

Γραμμή εντολής/emacs www.alittlemadness.com/2010/05/31/
setting-up-an-android-project-build/

IntelliJ www.jetbrains.com/idea/webhelp/
enabling-android-support.html

MOTODEV Studio for Android developer.motorola.com/docstools/
motodevstudio/download/

Εργαλείο URL Περιγραφή

android developer.android.com/
guide/developing/
tools/index.html

Περιλαμβάνεται στο Android SDK. Χρησι-
μοποιείται για την δημιουργία, προβολή 
και διαγραφή AVD, δημιουργία και 
ενημέρωση έργων Android και για την 
ενημέρωση του δικού σας Android SDK.

Android Emulator developer.android.com/
guide/developing/
tools/emulator.html

Περιλαμβάνεται μέσα στο Android SDK. 
Σας επιτρέπει να αναπτύσσετε και να 
δοκιμάζετε εφαρμογές Android σ' ένα 
υπολογιστή.

Android Debug Bridge 
(adb)

developer.android.com/
guide/developing/
tools/adb.html

Περιλαμβάνεται μέσα στο Android SDK. 
Σας επιτρέπει να διαχειριστείτε την 
κατάσταση μίας συσκευής ή του 
εξομοιωτή.

Apache Ant ant.apache.org/ Εργαλείο δόμησης εφαρμογών.

Keytool και Jarsigner 
(ή ένα παρόμοιο 
εργαλείο υπογραφής)

developer.android.com/
guide/publishing/
app-signing.html

Περιλαμβάνεται μέσα στο JDK. Το Keytool 
παράγει ένα ιδιωτικό κλειδί για ψηφιακή 
υπογραφή των εφαρμογών σας Android. 
Το Jarsigner χρησιμοποιείται για υπογραφή 
των εφαρμογών.

Εικόνα 8 Άλλα IDE για ανάπτυξη εφαρμογών Android.

Εικόνα 9 Εργαλεία για την ανάπτυξη εφαρμογών Android σε άλλα IDE, εκτός του Eclipse 
(developer.android.com/guide/developing/other-ide.html).
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Αν δεν είστε ήδη εγγεγραμμένος στην ιστοθέση μας, πηγαίνετε στην www.deitel.com και κάντε κλικ 
στον σύνδεσμο Register κάτω απ' το λογότυπό μας, στην επάνω αριστερή γωνία της σελίδας. Συμπλη-
ρώστε τις πληροφορίες σας. Η εγγραφή είναι δωρεάν και δεν θα μοιραστούμε τις πληροφορίες σας 
με κανέναν. Σας στέλνουμε μόνο e-mail διαχείρισης λογαριασμού, εκτός και αν εγγραφείτε στο δωρεάν 
ενημερωτικό μας δελτίο μέσω e-mail, Deitel® Buzz Online, στην:

www.deitel.com/newsletter/subscribe.html
Αφού εγγραφείτε στην ιστοθέση μας, θα δεχθείτε ένα e-mail επιβεβαίωσης, με τον κωδικό επαλήθευ-
σης – παρακαλούμε σιγουρευτείτε ότι έχετε εισάγει την διεύθυνσή σας e-mail σωστά. Θα χρειαστείτε 
τον κωδικό επαλήθευσης ώστε να εγγραφείτε στην www.deitel.com για πρώτη φορά. ∆ιαμορφώστε 
τον πελάτη σας e-mail, ώστε να δέχεται e-mail από την deitel.com, για να σιγουρευτείτε ότι το 
e-mail επιβεβαίωσης δεν θα φιλτραριστεί ως σκουπίδια.
Στην συνέχεια, επισκεφθείτε την www.deitel.com και εγγραφείτε χρησιμοποιώντας τον σύνδε-

σμο Login, που βρίσκεται κάτω από το λογότυπο, στην επάνω αριστερή γωνία της σελίδας. Πηγαίνετε 
στην www.deitel.com/books/androidFP/. Κάντε κλικ στον σύνδεσμο Examples για να φορτώσετε 
το αρχείο Examples.zip στον υπολογιστή σας. Κάντε διπλό κλικ στο Examples.zip για να απο-
συμπιέσετε την αρχειοθήκη.

Τώρα είστε έτοιμοι να αρχίσετε να αναπτύσσετε εφαρμογές Android με το βιβλίο μας. ∆ιασκεδάστε 
το!
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